2 Information management

Information management consists of storing and retrieving information used in
the analysis from the project web site (ww.hatcheryreform.us) and running
analyses with the offline All H Analyzer (AHA) application. The next two
sections describe the online web site application and how to run the offline AHA
application.

2.1  Web Site User Guide

This user's guide explains how to use the All H Analyzer (AHA v. 13) data
management tools accessible from the Hatchery Reform website
(www.hatcheryreform.us). The website tools allow hatchery managers, agency
personnel, planners, and members of the public to obtain the offline AHA
application and datasets necessary to review and update an AHA analysis.

The AHA tool is used to evaluate management strategies for salmon and
steelhead populations in the Pacific Northwest. This guide does not address in
detail use of the AHA tool. That information may be found in Section 2.2 of this
User’s Guide.

2.1.1 Background

The AHA tool has been used by the HSRG to organize information and evaluate
the effects of hatchery operations, harvest, mainstem passage survival
(hydropower) and habitat conditions on populations of salmon and steelhead in
the Columbia Basin, as well as to develop recommendations to better achieve
goals identified by managers.

The Columbia River Hatchery Reform System-wide Report details the results of
the HSRG review of all salmonid hatcheries and hatchery programs in the U.S.
portion of the Columbia River Basin. It contains a description of principles and
recommendations advocated by the HSRG and a discussion of how to analyze a
hatchery program to determine the “best” solution for achieving conservation and
harvest goals. This Hatchery Reform Project website is one of the
recommendations that grew out of the HSRG review.

2.1.2  Who may use the hatchery reform website?

Portions of the hatchery reform website, including population data files, global
datasets, the AHA tool, and supporting documentation, are available to all users.
Uploading new population datasets and global datasets is restricted to users with
administrative privileges.

2.1.3  How to get help with the website

Users may obtain help with the site by contacting the Hatchery Reform
webmaster.

2.1.4 The AHA Tool

The All-H Analyzer tool (AHA v. 13) is a stand-alone Microsoft Excel-based
desktop application which can be downloaded for free on this website. The
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All-H Analyzer refers to the four “Hs” which comprise the main influences on
salmonid populations in the Columbia River Basin: habitat, harvest, hatcheries,
and passage through hydroelectric dams. The tool contains calculations and
summary graphics of salmon fisheries characteristics based on:

e Habitat patterns

e Harvest patterns

e Hydroelectric dam operation patterns
e Hatchery operations

AHA estimates reflect a measure of hatchery influence on natural populations
that is a function of both the percent hatchery-origin spawners in the natural
escapement and the percent of natural-origin broodstock incorporated into the
hatchery program (Appendix C, System-wide Report).

The purpose of the AHA tool is to allow managers to explore the implications of
alternative ways of balancing hatcheries, harvest, habitat, and hydrosystem
constraints. This tool is not used to make decisions nor is it used to judge the
“correctness” of management policies. Rather, it illustrates the implications of
alternative ways of balancing the four “Hs” so that informed decisions can be
made. AHA should not be viewed as a “new” tool to predict habitat, harvest or
hydroelectric system effects on salmonid populations; it really is a platform for
integration of existing analyses. It is a relatively simple aid to regional decision-
making which can rapidly explore the potential impacts of a variety of detailed
scenarios relating to one or more “Hs”.

Data Sets
The AHA tool uses the file types shown in Table 6.

Table 6. AHA application file types

File Type Suffix | Format | Contents

Hatchery/Population Data * 1ol text Data for multiple scenarios for a hatchery program/natural
population

Stray Matrix File *smx | xml Global data that describes stray rates of hatchery adults

Habitat Pattern Dataset File | *.hab | xml Global habitat data

Harvest Pattern Dataset *hrv | xml Global harvest data

File

Hydro Pattern Dataset File | *hyd | xml Global hydroelectric operation data

The hatchery/population dataset contains data from all Columbia basin
populations and hatchery programs for the selected species. The dataset contains
a six-scenario “6-pack”. The first scenario of the 6-pack is always the current
condition and the sixth scenario is always the historic condition. The user has
options to load the open slots with scenario information available from the web
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site. Population/Hatchery datasets are discussed further in the next section of this
guide.

The global datasets contain data that describe the following:

e Stray Matrix - Assumed stray rates of hatchery adult populations
e Habitat - Productivity/capacity inputs
e Harvest - Harvest rates

e Hydro - Mainstem passage and ocean survival of juveniles and adults

Step-by-Step Guide to the Hatchery Reform Website Data Tools

}> Note: Users do not need to login to download Data Sets, the AHA
tool, or supporting documentation. Users must have login credentials to
upload datasets to the central database.

Accessing the Tools Page:

Home>Analytical Tools>AHA v.13

On the Home page, click the Analytical Tools tab then select AHA v.13 from
the dropdown menu. This will bring the user to the “All-H”” Analyzer Tools
Page which provides access to the central database to allow the user to download
AHA datasets (Figure 1). Credentialed users (administrators) may download and
upload datasets.
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ano Welcome

Home | About | Reviews | Summary Conclusions

Welcome to Hatchery Reform Account Management
Weicome to the website for the Pacific Northwest Hatchery Reform Project. The US Congress established the Login

project in 2000 because it recognized that while hatcheries play a legitimate role in meeting harvest and
conservation goals for Pacific Northwest salmon and steelhead, the hatchery system was in need of
comprehensive reform.

The project’s independent sclentific review panel, the Hatchery Scientific Review Group (HSRG), has reviewed
all state, Iribal and federal hatchery programs in Puget Sound and Coastal Washingtan, and in the Columbla
River Basin.

For the HSRG's Report to Congress on Columbla River Basin Hatehery Reform, click here,
Fo the HSRG's full System-Wide Report on Columbia River Basin Hatchery Reform, click here.

Al othe? prodiiots

recommendations
this website.

o Batorm Brotacs _ i
tchery Reform Project - inc!

sget Sound/Coastal Washing

e HERG'S nrincioias. tols and
e HSRG's principles, 1o0is and

view - are available from the Reports page of

Home | About | Reviews | Summary | Tools | Reports | Links | Contact
© 2008 - Managing For Sucoess

Figure 1. Hatchery Reform Website Home Page.

Using the AHA v. 13 Tools: Tasks for All Users

Links on the AHA Tools Page allow all users to download files required to begin a
new AHA session or update global data for an existing AHA session. For
administrators, the tools page provides links to upload the latest global datasets
and AHA scenarios contained in a hatchery/population file.

Getting Started Wizard

The Getting Started link allows AHA users to download a complete file
package in *.zip format (Figure 2). The package contains current versions of the
datasets listed in Table 1, the AHA application, and the supporting
documentation needed to start an AHA session. The process is completed in 3
steps:
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800 Tools - AHA
@ (E\r" \/ X D) /?\,‘ E http: f fhatcheryreform.us/mfs tools faha/welcome_show.action

Most Visited ~ Getting Started  Latest Headlines ®

Google Q

& hatchery reform
Home | About | Reviews Summary Conclusions | Analytical Tools Reports Links | Contact Us

Analytical Tools

AHA Account Management

Wizards —
Getting Started

Begin an offline AHA session by configuring an AHA hatchery/population dataset of 6 scenarios ("6-Pack”)
and then downloading that 6-Pack and all other resources necessary to run AHA (including global data,
the AHA tool, and the user guide).

Download Global Data
Download just the latest global Habitat Pattern, Harvest Pattern, Hydro Pattern, and Stray Matrix data for
use in updating your AHA session with the latest information.

Administrative Tasks (administrators only)

Upload Global Habitat Pattern Dataset
Upload global Habitat Pattern data.

Upload Global Harvest Pattern Dataset
Upload global Harvest Pattern data.

Upload Global Hydro Pattern Dataset
Upload global Hydro Pattern data

Upload Global Stray Matrix Dataset
Upload global Stray Matrix data.

Upload Hatchery/Population Scenario Data
Upload Hatchery/Population Scenarios contained within a .rol file.

Figure 2. Getting Started Wizard.
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Getting Started>Step 1 of 3: Choose Species
Select the species from the box on the left (Figure 3); then click Continue to

proceed to Step 2 of 3.
ano Population Reports - Download
(:)TE QF) Q@ (T) (B hetp phatchary st/ mf pddownload_select_tpecies action i ‘\ S (IC]:( oo

Most Visited =  Gefting Started  Latest Headlines 3

% hatchery reform

Analytical Tools

AHA Account Managemant

Getting Started - Step 1 of 3: Choose Species = Login
[ eninook [ ("Continue )

Homa | About | Rviews | Summary | Toos | Fiaporta | Links | Cormet
Phates

by Mary Eeswnmta Phassgmphy. Joanph, Orgen.

Figure 3. Select species.
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>Step 2 of 3: Configure 6-pack

The six scenarios contained in a hatchery/population file are referred to as a “6-
pack.” Four scenarios are selected by the user from dropdown menus associated
with slots 2 through 5. As mentioned previously, slot 1 is always the current
condition and slot 6 is always the historic condition. The choices associated with
slots 2 through 5 are either specifically or generically named scenarios (Figure
4). Scenarios with an assigned name, e.g. “HSRG Sol”, indicate a scenario with
specific assumptions representing an analytical solution. The user may also
download a working scenario with inputs for one of the scenarios (e.g., multiple
copies of the current scenario). A user can edit inputs for any scenario in a
dataset, however most users may want to retain the information for a particular

scenario and create a new scenario to evaluate different strategies.

ARG Population Reports - Download

|°B) @ (E http:/ /hatcheryreform.us/mfs/tools /aha/rollup_download_show_configuration_form.action

75D (=

Most Visited =  Getting Started  Latest Headlines ®

& hatchery reform

Home | About Reviews | Summary Conclusions | Analytical Tools Reports Links

Analytical Tools

AHA

Getting Started - Step 2 of 3: Configure 6-Pack * Login

Select a scenario from the list or select a working scenario (where alternatives can be developed) and base it
on an existing scenario. This will build a dataset with the same information in more than one slot.
Configure Your AHA 6-Pack
Slot 1 Current
[ No Hat

HSRG Sol

Slot 2
Slot 3

based on: | Please Choose... [4]

Slot 5 Working 2 based on: | Please Choose... |

ES{ESES1E

(
Slot 4 [ working 1
(

Slot 6 Historic

{Historic
No Hat
+HSRG Sol
Reset )| (HSRG+Hab
ICurrent
HSRG+Hab_2

Home | About | Reviews | Summary | Tools | Reports | Links | Contact
Photos by Mary Edwards Photography. Joseph, Oregon
© 2008 - Hatchery Reform Project

Contact Us

Account Management

Figure 4. Select four of six scenarios to download.

Selecting a generic scenario will produce a second column to the right of the first
column. From the dropdown menu, the user is prompted to select the base
scenario. This base scenario defines the starting conditions for the user when

working with the editable scenario.
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i Note that all slots must be filled and that entries must be unique.

Here is an example of producing a scenario 6-pack. The user has made the
following selections for the selectable slots shown in Figure 5:

Slot 1: This is always the Current scenario. The user may not select
another scenario.

Slot 2: “No Hat” scenario was selected by user. This scenario represents
a specific scenario in the database.

Slot 3: The user has selected the HSRG Sol scenario. This scenario
represents a specific scenario in the database.

Slot 4: The user has selected a “working” scenario based on the
HSRG+Hab Scenario.

Slot 5: The user has selected a “working” scenario based on the Current
Scenario (Slot 1).

Slot 6: This is always the Historic scenario. The user may not select
another scenario.

After each slot is filled, the user clicks the button marked Continue on the lower
left of the panel to proceed to Step 3 of 3.

Population Reports - Download

L. Relo)
@D @ (E http://hatcheryreform.us/mfs/tools/aha/rollup_download_show_configuration_form.action ';J‘V\ - (' Google

Most Visited ~  Getting Started  Latest Headlines &

& hatchery reform
Home About Reviews | Summary Conclusions Analytical Tools Reports LUinks Contact Us

Analytical Tools

AHA Account Management
Getting Started - Step 2 of 3: Configure 6-Pack » Login

Select a scenario from the list or select a working scenario (where altematives can be developed) and base it
on an existing scenario. This will build a dataset with the same informaticn in more than one slot.

Configure Your AHA 6-Pack

Slot 1 Current

Siot2 | NoHat ]
slots [ HSRGSol ]
siot4 [ Workingl  1%] based on: [ HSRG+Hab &)
Slot 5 [ Working 2 a based on:

Slot 6 Historic

("Reset )( Continue )

Home | About | Reviews | Summary | Tools | Reports | Links | Contact
Pholos by Mary Edwards Photography. Joseph, Oregon
© 2008 - Hatchery Reform Project

Figure 5. Fully configured 6-pack.
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>>Step 3 of 3: Download

Through a link on the Download page, the user can access the configured AHA

dataset (6-pack) package (Figure 6). The package contains the following:

e Scenarios specified on the Configure 6-pack page in a
hatchery/population file.

e Four global datasets
e The AHA application

e Supporting documentation

@ le\] ( %) lf;\'.l hitp:,fle?.D.O.l.BOBD.n'mfsJtau\s;’aha,‘rolIup_duwn\oad_oﬁer_ﬁles.action'"H' \ ' Google Q)

|Oe® Population Reports - Download =l

Most Visited * Getting Started Latest Headlines &

% hatchery reform
Home About Reviews Summary Conclusions Analytical Tools Reports Links Contact Us

Analytical Tools

AHA Account Management

Getting Started - Step 3 of 3: Download Login
You're now ready to download!

You'll find the download link below for everything you need to get started with a offline AHA session. The zip
file contains the AHA tool and all necessary datasets (global data Is contained in the global folder). A user
quide, and additional documentation of the AHA analytical methods is contained in a doc Tolder.

If you already have the latest version of the AHA tool or the latest global datasets, you will not need to extract
them from the zip file. However, be sure 1o check that those files are the most recent versions available
(compare the datestamp in each filename on your local system to the datestamps in the filenam ontained in
the zip file).

Download your configured AHA 6-Pack Package
w aha 6-pack Chinook 2009-02-19 1144.zip

Figure 6. Click link to download zip file.

Columbia River Hatchery Reform Project
Final Systemwide Report — Appendix D
User Guide

Page 47



Download Global Data Wizard

Tools>Download Global Datasets>choose data sets

Choosing this link allows the user to download the current global data sets.
Downloading the current global datasets allows the user to update an existing
AHA session. From the main Tools page, select Download Global Datasets
(Figure 7). The new page will have links for Stray Matrix, Habitat Patterns,
Harvest Patterns, and Hydro Patterns (Figure 8). Click on any of the links to
download the current global data set to your hard drive.

» Note that the filenames are date-stamped, allowing the user to determine
if global datasets used in their AHA session are outdated

600

@ (G ) () () ([E] nutp://127.0.0.1:8080/mfs tools /aha/welcome_show.action 23 ¥ 1= (Gl Google

Tools - AHA

Most Visited v  Getting Started  Latest Headlines &

4 hatchery reform

Analytical Tools

AHA

Wizards

Getting Started

resources necessary for a new AHA session

Download Global Data
in updating your current AHA session

Administrative Tasks (administrators only}

Upload Global Habitat Pattern Dataset
Upload global Habitat Pattern data
Upload Global Harvest Pattern Dataset
Upload global Harvest Pattem data.
Upload Global Hydro Patter Dataset
Upload global Hydro Pattern data
Upload Global Stray Matrix Dataset
Upload global Stray Matrix data.

Upload Hatchery Scenarid Data

UploattHs y-STENarios contained within a .rol file.

Begin a new AHA session by conflguring an AHA 6-Pack and then downloading that 6-Pack and all other

Download the latest global Habitat Pattern, Harvest Pattern, Hydro Pattern, and Stray Matrix data for use

Summary Conclusions | Analytical Tools | Reports | Links | Contact Us

Account Management

Login

Figure 7. Global Data Download Wizard.
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800 AHA GLobal Data - Download

@9 () (X)) (M) hitp://127.0.0.1:8080/mfs {tools/aha/update_global_data_show.action

e (O]

Most Visited v  Getting Started  Latest Headlines 3

“ hatchery reform
Home | About | Reviews | Summary Conclusions | Analytical Tools | Reports

Analytical Tools

AHA Global Data Download

Download each of the global datasets below to your local system. Load each of those datasets into your AHA
Rall-Up session using the AHA Roll-Up Tool.

Download the latest global Habitat Pattern Data
() habitat_patterns_2009-02-19.nab

Download the latest global Harvest Pattern Data
() harvest patterns_2009-02-18.hrv

Dowload the latest global Hydro Pattern Data
) hydro_patterns_2009-02-18.nyd

Download the latest global Stray Matrix dataset
) stray_matrix_2008-02-18.smx

Once the global datasets are downloaded to your computer, you can load them into your AHA session by
opening the offline AHA tool and from the AHA application menu go to File>COpen to launch the file dialog
screen. The file dialog screen will ask you to locate each of the global datasets on your local system. Complete
instructions are provided in the Section 2.2.4 - Running AHA: A Quick-Start Primer in 5 Easy Steps of the AHA
user guide.

Links | Contact Us

Account Management

Login

Figure 8. Select global data file to download.

Using the AHA Tools: Tasks for Administrative Users

This section outlines the procedure for uploading datasets to the central

database. These activities are for administrators only. Administrators must

have login credentials to use the upload tools.

>> Note that uploading any dataset will replace the existing dataset in the

system.

Logging In

Any website page>Account Management>Login

On any of the website pages, click on the Login button below the Accounts
Management heading (Figure 9). The Login page appears. Enter your name and
password in the provided boxes and click on Login (Figure 10).
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Figure 10. Enter username and password.
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Under the heading “Administrative Tasks (administrators only)”, there are 5 links which
may be used to upload files to the remote database:

e Upload Global Habitat Pattern Dataset
e Upload Global Harvest Pattern Dataset
e Upload Global Hydro Pattern Dataset
e Upload Stray Matrix Dataset

e Upload Hatchery Scenario Data

A H A Accouy

L n
Wizards =ogn
» Getling Started

Begin a new AHA session by configuring an AHA 6-Pack and then downloading that 6-Pack and all other
resources necessary for a new AHA session.

» Download Global Data

Download the latest global Habitat Pattern, Harvest Pattern, Hydro Pattern, and Stray Matrix data for use
in updating your current AHA session.

ators only)

» Upload Global Habitat Pattern Dataset

Upload global Habitat Pattern data.

» Upload Giobal Harvest Pattern Dataset

Upload global Harvest Pattern data.

» Upload Global Hydro Pattern Dataset

Upload global Hydro Pattern data.

» Upload Global Stray Malrix Dataset

Upload global Stray Matrix data.

» Upload Hatchery Scenaric Data

ed within a .rol file.

Figure 11. Administrative Tasks links.

The first four links allow the user to upload global datasets; the last link allows
the user to upload an AHA hatchery/population file. Note that uploading a
global dataset will replace the current dataset in the central database.
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Upload Global Data
To upload global datasets:

1. Select type dataset to upload. A page similar to Figure 12 will load.
2. Browse to the location of global dataset.

3. Click Upload

4. Use the same procedure to upload any of the four global datasets.

NOe® HRP Habitiat Pattern Upload
@ (E http:/ fhatcheryreform.us/mfs/tools/admin/habitat_pattern_upload_form_show.action uﬁv_‘) . (' Googl
Most Visited ¥ Getting Started  Latest Headlines ®

& hatchery reform
Home | About | Reviews | Summary Conclusions | Analytical Tools | Reports | Links | ContactUs

Analytical Tools N
Habitat Pattern Dataset Upload Account Management
Upload your Habitat Pattern dataset. + Welcome admin

» Logout
CAUTION: this uploaded dataset will completely replace the existing Habitat Pattern dataset in the system.

This update should only be made to replace information for an existing habitat pattern or to add a new habitat
pattern data to be used with a hatchery/population scenario.
Habitat Pattern Dataset (in xml format): ( Browse... )

Upload Warning: Clicking upload button will replace Habitat Pattern Data

Home | About | Reviews | Summary | Tools | Reports | Links | Contact
Photos by Mary Edwards Photography. Joseph, Oregon

© 2008 - Halchery Reform Project

Figure 12. Select global dataset to upload.

A confirmation page with a unique dataset ID will appear after a successful
upload. The dataset ID is referenced by the AHA scenarios to ensure scenarios
are based on the current global datasets. The significance of referencing a correct
dataset ID is discussed in the following section.
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Upload Hatchery/Population Scenario Data
To upload hatchery/population scenario data:

1.

From the Analytical Tools page, click the Upload Hatchery Scenario
link.

Browse to the scenario 6-pack file.
Click Upload.

If the global dataset IDs in the hatchery/population file match those of
the global datasets, the user is then prompted to specify which scenarios
in the dataset to upload (Figure 13).

Note: If the global dataset IDs in the hatchery/population file do not
match the current global dataset IDs, an error message similar to that
shown in Figure 14 will be displayed. Synchronization of dataset IDs is
discussed in the next section.

After selecting scenarios to upload, click Upload. A confirmation page
will appear indicating a successful upload.

NEPA 4B
NEPA 5B

Cur w/Hab
Mo Hat

HSRG Sol
HSRG+Hab
CoManage

No Hat w/Hab

NEPA 1A

MNone
Mone
MNone
2009-02-17 10:51:00 | Replace Existing Scenario ?]
2009-02-17 14:56:54 ' Replace Existing Scenario _ﬂ

2009-02-17 10:50:56 lgnore {(do not upload) & ]

Non gnore (do not upload)
b ‘Replace Existing Scenario

None

MNone

Figure 13. Select scenarios to upload.
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“ hatchery reform

Hatchery Reform

Error

An Error Qccurred:

Error parsing Rollup File. Your Dataset references a global Stray Matrix Dataset with an ID of 111217. This
Dataset does not currently exist in the system. Please ensure the referenced global Dataset is present and
then retry your upload

S

Figure 14. Error message caused by unsynchronized global dataset IDs.

Synchronizing Global Dataset 1Ds

As mentioned previously, an upload error is generated if pattern dataset IDs in
the hatchery/population file do not match the respective IDs in each of the
current global datasets. The user must synchronize the pattern IDs in the
hatchery/population file with the current pattern datasets using one of the two
methods outlined below:

7

¢ Method 1: If the scenarios are intended to be based on the global
datasets currently in the central database, the user should update the
local global datasets on their computer and synchronize the
hatchery/population file following this procedure:

1. Download the current global datasets from the hatchery reform website.
2. Open a new offline AHA session.

3. Load the downloaded datasets into the AHA tool. (This procedure is
discussed in detail in the AHA User’s Manual, Section 2.2.4, Appendix
D of the System-Wide Report.

4. Reload the hatchery/population file into AHA. The AHA tool will
automatically update the patterns IDs in the file.

5. Re-save the hatchery/population dataset to be uploaded.
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6. Upload the hatchery/population file following steps 1-5, Upload
Hatchery Scenario Data.

+» Method 2: If the scenarios are based on global datasets newer than
those currently in the central database, the user should first update the
global datasets in the central database and synchronize the scenario file
following the procedure outlined below:

1. Upload the new global datasets used in the AHA session.

2. Download those same global datasets from the website. A new pattern ID
will be generated indicating the global datasets originated from the
central database.

3. Load the downloaded global datasets into the user’s current AHA
session.

4. Resave the hatchery/population dataset to be uploaded.
5. Follow steps 1-5, Upload Hatchery Scenario Data.

Population Management Tools

This section discusses the population management tools accessible from the
Hatchery Reform website. All users are able to view population data. Users with
login credentials are permitted to add and modify populations.

The population management tools allow users to add new populations, view and
edit existing populations, and disable (but not delete) populations. In addition,
users may view a population modification history table. Users should be aware
that once a population is added or modified additional data synchronization is
required using the offline AHA tool.

To access the population tools, select the Population Management link from the
Analytical Tools tab:

Analytical Tools > Population Management
A page similar to that shown in Figure 15 will load.
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& hatchery reform
Home About Reviews Summary Conclusions Analytical Toals Reports Unks Contact Us

Analytical Tools

Account Management

Population Management
Login

Tools (only admin tasks require login)

Create Population
Create a population entry.
Documentation
View Population Modification History
View the population modification history. Using the Analytical Tools
Portion of this Web-Site

Rename or Disable an Existing Population
Rename or Disable an Existing Population

Figure 15. Population Management main page.

Create Population

To create a new population, click the Create Population link from the Population
Management main page. The user will be prompted to login if they haven’t
already done so. A page similar to that shown in Figure 16 will load.

The user is required to provide the following information:

e Population Name — Enter the name of the new population. The mythical
salmon population Sullivan’s Gulch Chinook is shown as an example in
Figure 2.

e User Name — The user is required to enter their name in this field. This
information is necessary to identify to person posting the data as
Hatchery Reform website login accounts may have several individual
users.

e Explanation — The user should enter a brief description of the new
population in this field. The description may contain up to 1024
characters.

Once the fields are complete, click Continue.
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Analytical Tools

H Account Management
Create Population
Login
Step 1 of 3: Population Name (only admin tasks require login)

Population Name: * |Sullivan's Gulch Chinook

Documentation
Change History

Using the Analytical Tools
All population related actions are tracked and recorded. IN ADDITION to your action above, please enter Portion of this Web-Site

information about yourself and your reason for this action.
Your Full Name: ™ |John 5. Doe

Explanation: *
John Doe's population.|

( Cancel ) ( Continue )

* required fields

Figure 16. Step 1 of 3, enter required data.

In the second step, the user is prompted to confirm that the submitted data are
correct. This is shown in Figure 17. If the information is correct, click Continue
and a page indicating success will load (Figure 18). Note that a unique identifier
is generated for the new population.
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& hatchery reform

Analytical Tools

Create Population

Step 2 of 3: Confirm Name
Population Name: Sullivan's Gulch Chinook
User Name: John S. Doe

Explanation:
John Doe's population

("Cancel ) ( Continue )

Home | About

Summary Conclusions Analytical Tools Reports Links Contact Us

Account Management

» Welcome admin
» Logout

Documentation

» Using the Analytical Tools
Portion of this Web-Site

Figure 17. Confirm submitted data.

& hatchery reform

Home | About

Analytical Tools

Create Population

Step 3 of 3: Success!

Click here to return to the main population management page

You've created population: 'Sullivan's Gulch Chinook’ with |d: 5006

Summary Conclusions Analytical Tools Reports Links Contact Us

Account Management

» Welcome admin
# Logout

Documentation

» Using the Analytical Tools
Portion of this Web-Site

Figure 18. Confirmation page.

View Population Modification History

The View History table lists modification actions for all populations. Users may

view the table without logging in.

To access the View History Table, click the link on the Population Management
Tools main page (Figure 15). A page similar to that shown in Figure 19 will load.
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% hatchery reform

Analytical Tools =P

View History

Click here 1o return to the main population management page

Home About Reviews | Summary Conclusions Analytical Tools Reports Links Contact Us

Account Management

» Welcome admin
Logout

Date Type

Jul 7, 2009

s
1:35:21 AM  CREATE

Account 1D Name Full Name Explanation
Sullivan's
admin 5,006 Gulch John S. Dae John Doe's Population

o " Documentation
Chinaok

Using the Analylical Tools
Portion of this Web-Site

Figure 19. Population Modification History page.

The table has seven columns:

Date — The date and time the modification was made.

Type — The type of modification. Possible values are CREATE,
RENAME, and DISABLE.

Account — The login account used to access the Hatchery Reform
website tools.

ID — The unique identifier assigned to the modification event.
Name — The population name.
Full Name — The person responsible for the modification.

Explanation — Explanatory notes.

Modify an Existing Population

To view enabled populations in the Hatchery Reform database, click on the
Rename or Disable an Existing Population link found on the Population
Management main page (Figure 15). A page similar to that shown in Figure 20
will load.

Users with login credentials are permitted to edit the population name or disable
the population entirely. To rename an existing population, click on the Rename
link in the Action column next to the population to be modified. The example
shown in Figures 21 through 23 renames the Sullivan’s Gulch population from
“Chinook” to Coho”.
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Home | About | Reviews

Analytical Tools

Population Management

Rename or Disable an Existing Population:

Summary Conclusions | Analytical Tools

) Population Name. Action
208 2-Asotin Summer Steelhead (A-run) Rename
213 Grande Ronde_Lockingglass Creek Spring Chinook Rename
214 Grande Ronde_Catherine Creek Spring Chinook Rename
215 7-Grande Ronde_Lostine Spring Chinook Rename
216 Grande Ronde_Upper Grande RondeSpring Chinaok Rename
217 8-Grande Ronde_Lower Grande Ronde Summer Steelhead Rename
218 8A-Grande Ronde_Cottonwood Craek Summer Steelhead (Wallowa-Lyens Ferry- o
Hatchery) .
220 10-Grande Ronde_Wallowa Summer Steelhead Rename
222 9-Imnaha Spring-Summer Chinook Rename
223 24-Imnaha Summer Steelhead Rename
224 Snake Hells Canyon Fall Chinook Rename

Disable
Disable
Disable
Disable
Disable

Disable
Disable
Disable
Disable
Disable

Disable

Reports | Links | Contact Us

Account Management

Welcome admin
Logout

Documentation

Using the Analytical Tools
Portion of this Web-Site

Figure 20. Step 1, rename population.

“ hatchery reform

Home | About | Reviews

Analytical Tools

Rename Population

Step 1 of 3: Rename Population

Summary Conclusions | Analytical Tools

Population Name: | Sullivan's Gulch Chinook

Change History

information about yourself and your reason for this action
Your Full Name: * | Jehn S. Doe

Explanation: *
Coho, not Chinocok.

(“cancel ) ( Continue )

* required fields

All population related actions are tracked and recorded. IN ADDITION to your action above, please enter

Reports | Links

Account Management

Welcome admin
Logout

Documentation

Using the Analytical Tools
Portion of this Wi

Figure 21. Step 1, rename population.
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& hatchery reform

Analytical Tools

Rename Population

Step 2 of 3: Confirm Rename
Population Name: Sullivan's Guich Chinook
User Name: John 5. Doe

Explanation:
Coho, not Chinook.

("cancel) ( Continue )

Home | About | Reviews | Summary Conclusions | Analytical Tools | Reports | Unks | Contact Us

Account Management

Welcome admin
Logout

Documentation

Using the Analytical Tools
Portion of this Web-Site

Figure 22. Step 2, confirm edits.

& hatchery reform

Analytical Tools

Rename Population

Step 3 of 3: Population Update Successfull!

Click here to return to the main population management page

Home | About | Reviews | Summary Conclusions | Analytical Tools | Reports | Links | ContactUs

Account Management

Welcome admin
Logout

Documentation

Using the Analylical Tools
Portion of this Web-Site

Figure 23. Step 3, confirmation page.

To disable a population, click the Disable link next to the population name in the
main page table. If the Disable links are grayed out, additional steps are required
as population cannot be disabled until all datasets that reference it are first edited.

To delete references to the population, the user must edit each file that references
that population using the offline AHA tool. These files will include one or more
of the pattern datasets, as well as a population-hatchery data file (formerly called
a rollup file). Once the population references are deleted, the files must be
uploaded using the HRP website upload tools. After a successful upload, the
disable link become active, and the population can then be disabled. Note that
disabling a population removes it from the table on the main page but does not
delete it from the underlying data tables.

Columbia River Hatchery Reform Project

Final Systemwide Report — Appendix D
User Guide

Page 61



3 References

Budy, P. and H. Schaller. 2007. Evaluating tributary restoration potential for pacific
salmon recovery. Ecological Applications, 17(4): 1068-1086.

NMFS (National Marine Fisheries Service). 2008. Endangered Species Act — Section 7
Consultation Biological Opinion and Magnuson-Stevens Fishery Conservation
and Management Act Consultation on remand for operation of the Federal
Columbia River Power System and 19 Bureau of Reclamation Projects in the

Columbia Basin. NMFS, Portland, Oregon.

Columbia River Hatchery Reform Project
Final Systemwide Report — Appendix D
User Guide Page 106



	2.1 Web Site User Guide 
	2.1.1 Background
	2.1.2 Who may use the hatchery reform website?
	2.1.3 How to get help with the website
	2.1.4 The AHA Tool 
	2.1.5 Data Sets
	2.1.6 Step-by-Step Guide to the Hatchery Reform Website Data Tools

	3 References



